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Preface 
 

This Quick Start Guide provides a fast and friendly introduction on FINE NGAS’ main 
features and functionalities. In conjunction with this guide, you can find helpful step-by-
step videos in www.4msa.com. All the features and functions of the program are 
presented and explained in detail within the complete User’s Guide, along with informative 
examples. 

FINE NGAS, the Fully INtegrated Environment for Natural Gas Installations combines both 
designing and calculations in a uniform, integrated environment, consisting of two main 
components, CAD and Calculations:  

• Concerning the CAD component, it is based on an autonomous CAD embedding 
4MCAD engine adopting the common cad functionality and open dwg drawing file 
format. The CAD component helps the user design and then calculate and produce 
completely automatically the entire calculations issue for every Gas installation project, 
as well as all the drawings in their final form. 

• Concerning the Calculations component (called also as ADAPT/FCALC), it has been 
designed according to the latest technological standards and stands out for its unique 
user - friendliness, its methodological thoroughness of calculations and its in-depth 
presentation of the results. The GAS Calculation module acquires data directly from the 
drawings (automatically), thus resulting in significant time saving and maximum reliability 
of the project results. It can also be used independently, by typing data within the 
calculation module spreadsheets. 

Despite its numerous capabilities, FINE NGAS has been designed in order to be easy to 
learn. Indeed, the simplicity in the operation philosophy is realised very soon and all that the 
user has to do is to familiarise himself with the package.  

This Guide is divided into 3 short parts: 

- Part 1 describes the installation procedure and the main menu structure. 
- Part 2 deals with the CAD component of FINE NGAS, showing its philosophy and 

main features. 
- Part 3 describes the calculation environment of FINE NGAS. 
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1. Installation - Launching 
 

1.1 Installing FINE NGAS 
1. Insert the CD in your computer CD-ROM drive (e.g. D:, E:) or, if you received your 

software via Internet, run the installation application you downloaded. 

2. When the Welcome page appears (as shown below), click Next. 

 
3. When the License Agreement appears, read it carefully. If you agree with the terms, 

check the respective “radio button” and then click Next (you must agree with the terms 
to proceed with the installation). 

4. In the next screen enter your username and organization information and check if you 
want to create a desktop icon. Then click Next to see if the information is correct (see 
the following window) and finally click Install for the installation procedure to begin. 

5. Upon completion of the installation procedure, the following last window appears on 
screen and all needed is to click Finish. In case that the Run FINE 14NG checkbox is 
selected, the program will start running. 
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6. After installation, the program is located within the programs list. 
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2. CAD Component 
 

2.1 Overview 
Fine NGAS is a powerful Workstation for Natural Gas installations which automatically 
performs the necessary calculations directly from the drawings, producing all the case 
study results (calculation issue, technical descriptions, full-scale drawings, bills of 
materials etc.). This first Part (Part I) of the user's guide describes the operation of the 
CAD component of Fine NGAS. As mentioned in the preface, the CAD component is 
based on 4MCAD technology. Furthermore this CAD component is considering the building 
and natural gas installation as being composed of intelligent entities with their own 
attributes and properly related each one to each other. Fine NGAS CAD Component 
includes 2 main modules, which co-operate closely and give the Designer the impression 
he virtually works on the building: It is about a) AutoBLD that is used to load-identify the 
building and b) AutoNET that is used to design and identify the network installations. 
Those two subsystems are supported by a third one, with the name PLUS, which includes 
many useful designing facilities. 
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2.2 Main menu  
As soon as the program is loaded, the main menu screen appears for the first time: 

 
Among the commands of the designing environment, we notice the following main options 
of the package: 

1. Project files management options (New Project, Open Project and Project Information) 
which are located into the options group FILE. 

2. Option Group with the name AutoBLD, which includes all the commands required for 
the Architectural designing. 

3. Option group with the name AutoNET, which includes all the commands required for 
the designing and calculation of the application (Single-pipe system, Twin-pipe System, 
Electrical Wiring etc). 

4. Auxiliary option group with the name PLUS, which contains a series of designing 
facilities for the user. 

To start creating a project with FINE, a new project should be defined by utilizing the 
corresponding option in the project FILE 
management menu mentioned above. 
In case that "NEW PROJECT" is 
selected, a window appears on the 
screen where the name of the Project 
should be typed. 
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In order to "load" an existing project, which has been created with the program and 
you want to further edit it or just view it, you choose "Select Project", and a list with the 
existing projects in the hard drive will be displayed on the screen. At first, the list displays 
all the projects that exist in the FINE directory and with the use of the mouse or the 
keyboard and acting correspondingly, you can transfer to any other directory, viewing at 
the same time the existing 
projects. It is noted that the 
projects are included into 
directories with the extension 
BLD. If an existing project is 
selected, it is loaded and 
displayed on the screen. 

Either if a new project is 
created or a saved one is 
loaded, you can start working 
with the use of the subsystem 
commands described above. A 
detailed description of these 
commands is available in the 
following chapters. Before this 
detailed description, a short 
reference of the basic designing principles featured in the designing environment of the 
package is recommended, in chapter 2.3 that follows next. If you are familiar with the use 
of 4MCAD or AutoCAD, you may page through or even skip this chapter, while if you are 
not, you should read it carefully. 

2.3 Drawing Principles & Basic Commands 
A great advantage of the package is that the structure and the features of the drawing 
environment follow the standards of the CAD industry adopted by AutoCAD, 4MCAD etc. 
In particular, the available working space is as follows: 

 
As shown in the above figure, the screen is divided into the following "areas": 
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• Command line: The command line is the area where commands are entered and the 
command messages appear. 

• Graphics area: The largest area of the screen, where drawings are created and 
edited. 

• Cursor: The cursor is used for drawing, selecting objects and running commands from 
the menus or the dialog boxes. Depending on the current command or action, the 
cursor may appear as a graphics cursor (crosshairs), a selection box, a graphics cursor 
with a selection box etc. 

• Pull-down menus: Each time you select one of these commands (AutoBLD, AutoNET 
etc.) a pull-down menu is shown. 

• Status Line: It is the line on the bottom of the screen where the current level, the 
drawing status and the current cursor coordinates are displayed. From the status line 
you can enable or disable tools such as SNAP, GRID, ORTHO etc., which are 
explained in the following chapter. 

Toolbars: You can arrange which toolbars you want to be shown in the screen in each 
project. To enable or disable a toolbar, in the upper part of the screen (where the existing 
toolbars are shown) right click with the mouse and select the desired toolbar from the list 
(as it is shown below). 

 
Apart from that, each time you select an application from the AutoNET menu, a toolbar 
with the name of the application is shown and you can either work from there or from 
the AutoNET commands.   

2.3.1 Drawing aids 
This section describes the most important drawing aids. These are the commands: 

SNAP: The graphics cursor position coordinates appear in the middle of the upper part of 
the graphics area. If "Snap" is selected, the graphics cursor movement may not be 
continuous but follow a specific increment (minimum movement distance). To change the 
increment, right click with the mouse on “SNAP” and choose “Settings”. To activate or 
deactivate it, double click on the “SNAP” icon. 

GRID: The screen grid is a pattern of vertical and horizontal dots, which are placed at the 
axes intersection points of an imaginary grid. The grid can be activated or deactivated by 
clicking the corresponding icon or by pressing F7.  

ORTHO: The "Ortho" feature restricts the cursor to horizontal or vertical movement. The 
status bar shows whether the "Ortho" command is activated by displaying "ORTHO" in 
black characters. The command is activated or deactivated by clicking the corresponding 
icon or by pressing F8. 
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ESNAP: The "Esnap" command forces the cursor to select a snap point of an object, 
which is within the Pick box outline. The esnap points are characteristic geometric points 
of an object (i.e. endpoint of a line). If you have specified a snap point and move the 
cursor close to it, the program will identify it with a frame. The "Esnap" command can be 
activated either by holding down the "SHIFT" key and right clicking the mouse or through 
the additional toolbar. 

2.3.2 Drawing Coordinates 
When you need to determine a point, you can either use the mouse (by seeing the 
coordinates in the status bar or using the snap utilities), or enter the coordinates directly in 
the command line. Moreover, you can use either Cartesian or polar coordinates and 
absolute or relative values, in each method (relative coordinates are usually more 
convenient). 

Relative coordinates: Enter the @ symbol (which indicates relative coordinates) and 
then the x, y, z coordinates (Cartesian system) or the r<θ<φ coordinates (polar system) in 
the command line. The system used (Cartesian or polar) is defined by the “,” or “<” symbol 
respectively. If you do not insert a value for z or φ, it will be automatically taken as zero. 
For example, if you are prompted to locate the second (right) endpoint of a 2m horizontal 
line, you enter: 

@2,0 if you use the Cartesian coordinates (which means that the distance of the second 
point from the first is 2 m on the x axis and 0 m on the y axis), or 

@2<0 if you use the polar coordinates [which means that the second point is at a distance 
of 2m (r=2) and an angle of 0 degrees (θ=0) from the first]. 

Absolute coordinates: They are specified in the same way as the relative coordinates 
but without using the @ symbol. The absolute coordinates are specified in relation to the 
0,0 point of the drawing. 

The measurement system can be activated, deactivated or changed with the F6 key. 

2.3.3 Drawing Basic Entities 
In the “Draw” menu you will find the basic drawing entities: 

Line: "Line" option is used for drawing segments. When you select "Line" from the menu 
or type "Line" in the command line, you will be prompted to specify a start point (by left 
clicking or by entering the point coordinates – relative or absolute – in the command line) 
and an endpoint (determined in the same way). 

Arc: The "Arc" command is used for drawing arcs. An arc can be drawn in different ways: 
the default method is to specify three points of the arc ("3-Points"). Alternatively, you can 
specify the start point and endpoint of the arc as well as the center of the circle where it 
belongs (St, C, End). You will not find it difficult to understand and become familiar with 
the various methods of drawing an arc. 

Polyline: This command allows you to draw polylines, which are connected sequences of 
line or arc segments created as single objects. The command is executed by either using 
the menu or typing "pline" in the command line. You will be prompted to specify a start 
point and an endpoint (by right clicking the mouse or by entering the point coordinates – 
relative or absolute – in the command line). Then, the command options will appear (Arc, 
Close, Length etc).  Select A to switch to Arc mode, L to return to Line mode and C to 
close the polyline. 

FINE NGAS - 7 - 



 
 

2.3.4 Useful Commands 
This section includes brief descriptions of the basic program commands, which will be 
very useful. These are the commands "Zoom", "Pan", "Select", "Move", "Copy" and 
"Erase" (you will find them in “View” and “Modify” menus). In particular: 

Zoom: "Zoom" increases or decreases the apparent size of the image displayed, allowing 
you to have a "closer" or "further" view of the drawing. There are different zooming 
methods, the most functional of which is the real-time zooming ("lens / ±" button). You can 
use the mouse to zoom in real time – that is to zoom in and out by moving the cursor. 
There are a number of zoom options as shown by typing "Zoom" in the command line: 
All/Center/Dynamic/Extents/Left/Previous/Vmax/window/<Scale(X/XP)>. 

Pan: "Pan" ("hand" icon) moves the position of the visible part of the drawing, so that you 
can view a new (previously not visible) part. The visible part of the screen moves towards 
the desired area and to the desired extent. 

Select: This command selects one or more objects (or the whole drawing), in order to 
execute a specific task (erase, copy etc.). Select is also used by other CAD commands 
(for example, if you use the "Erase" command, "Select" will be automatically activated in 
order to select the area that will be erased).  

Move: This command allows moving of objects from one location to another. When the 
"Move" command is activated, the "Select" command is also activated so that the object(s) 
you want to move (in the way described in the previous paragraph) can be selected. 

After you have selected the desired object(s), you are prompted to specify the base point 
(using the snap options), which is a fixed point of the drawing. When you are prompted to 
specify the position where the base point will be moved, use either the mouse or the snap 
options. After you have completed this procedure, the selected object(s) will move to the 
new position. Please note that the base and the new location points can be also specified 
with the use of coordinates (absolute or relative, see related paragraph). 

Copy: The "Copy" option allows the copying of objects from one location to another. The 
"Copy" procedure is similar to the "Move" procedure and the only difference is that the 
copied object remains at its original location in the drawing. 

Erase: Choose this option to delete objects. The procedure is simple: Select the objects 
you wish to erase (as described above), type "E" in the command line and press <Enter>. 
Alternatively, you may first type "E" in the command line, then select the object(s) by left 
clicking and finally right click to erase the object(s). 

DDInsert (Insert Drawing): This command allows you to insert another drawing (DWG 
file) or block in the drawing. When this command is selected, a window appears in which 
you select block or file and then select the corresponding block or file from disk. Then you 
are prompted to specify the insertion point, the scale factor etc., so that the selected 
drawing is properly inserted. 

Wblock: The "Wblock" command allows us to save part of a drawing or the entire drawing 
in a file, as a block. When this command is selected, you are prompted to enter the file 
name and then you select the drawing or the part of the drawing you wish to save. The 
use of this command is similar to the "Screen Drawing" command in the AutoBLD menu, 
which will be described in a following section. In order to insert a block in a drawing, you 
use the "ddinsert" command described above. 

Explode: The "Explode" command converts a block in a number of simple lines so that 
you can edit it in that form. If it is selected, the program will prompt you to select the block 
("Select object") you wish to explode. 
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2.3.5 Grips 
Grips are some characteristic points of an object, which appear after it is selected (by 
moving the cursor on the object and left 
clicking). The object is displayed with grips 
(small squares in blue colour), which mark 
control locations and are powerful editing 
tools (by selecting one grip you can for 
example, move or change the length of the 
line). When you click a grip, the following 
prompt appears in the command line: 
**STRETCH** <stretch to point> /Base point 
/copy/ undo/ exit. If you press <Enter> (or 
right click), the first characters of the 
corresponding word are entered, e.g. “sc and enter” for the "Scale" command). 

When a command is executed, grips disappear and the objects are deselected. If the 
command is an editing command (correction or copy), which can be preselected, the 
objects take part in the execution of the command automatically. In this case, the 
command overrides the "Select objects" prompt and proceeds. To deselect grips and 
objects you should press <Esc> twice: once to deselect the objects and twice to 
deactivate the grips. 

In each object the positions of the grips are different. Namely, for a point the grip is the 
point itself, for a segment the grips are the midpoint and the two endpoints, for an arc the 
midpoint and the two endpoints, for a circle the center and the quadrants, for a polyline 
the endpoints of the line and arc segments and the midpoints points of the arc segments, 
for a spline the spline points, for a block the insertion point, for text the insertion point etc. 

2.3.6 Print 
This section may be read after you have created a drawing and you want to print it. Any 
drawing can be printed using a printer or plotter or to a file. Printing is performed using 
"PLOT" command, selected either from the "FILE" menu or typing it in the command line, 
provided there is a drawing already loaded.  

Viewing a drawing before printing gives you a preview of what your drawing will look like 
when it is printed. This helps you see if there are any changes you want to make before 
actually printing the drawing. 

If you are using print style tables, the preview shows how your drawing will print with the 
assigned print styles. For example, the preview may display different colours or line 
weights than those used in the drawing because of assigned print styles. 

To preview a drawing before printing 
1. If necessary, click the desired Layout tab or the Model tab.  

2. Do one of the following:  

� Choose File > Plot Preview.  

� On the Standard toolbar, click the Plot Preview tool ( ).  
� Type ppreview and then press Enter.  

3. After checking the preview image, do one of the following:  

� To print the drawing, click Plot to display the Print dialog box.  
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� To return to the drawing, click Close. 

The Plot dialog box is organized in several areas as it is shown in the picture below. For 
help defining print settings before you print, see Customizing print options. 

In the plot window, you can select the printer, the paper size and the number of copies 
and several plot options such as the style (pen assignments), the orientation etc. 

Moreover, you can select the plot scale and the plot area. Before you proceed to printing, 
you select “Apply to layout” and then “Preview” so as to make any modifications you might 
want. 

To print a drawing 
1. If necessary, click the desired Layout tab or the Model tab.  

2. Do one of the following:  

� Choose File > Plot.  

� On the Standard toolbar, click the Print tool ( ). If you click the Print tool, the Print 
dialog box does not display. Your drawing will be sent directly to the selected printer.  

� Type print and then press Enter.  

3. From the Plot dialog box, make any adjustments to the settings.  

4. Click OK.  

 

2.3.7 Plus Drawing Tools 
Those tools belong to the large group of options under the general menu PLUS. These 
are a series of additional drawing tools, which have been embodied in the package in 
order to help the user during drawing, and are described within the Full User’s Guide. 
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2.4 AutoBUILD: Architectural Drawing  
The AutoBUILD option group, as we will see in detail below, includes all the facilities 
required to insert a building and create an architectural drawing. As it is shown in the 
corresponding AutoBLD menu, the various options are divided into several sub-groups. 

 
In general, the first sub-group includes commands for the definition of the project 
parameters, the second sub-group includes drawing commands, the third sub-group 
includes commands for linking to the calculations and the fourth includes management 
options for the AutoBLD libraries and commands for the building supervision. In the 
following sections, the options reported above are described one by one, beginning with 
the "Building Definition" option. 
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2.4.1 Building Definition 
If you select the "Building definition" 
option, the floor management menu 
appears. 

On this screen the levels of the building 
are defined, which means that you 
determine the level and the 
corresponding architectural drawing (a 
dwg file ground plan) of each building 
floor (only in case you use a drawing 
that was created by another 
architectural designing program). More 
specifically: 

� In the "Level" field, define the Level 
(floor) number. 

� In the "Elevation" field, define the height of the floor level. You can define manually a 
benchmark for level measurement (e.g. the pavement). You may also define negative 
levels (e.g. -3 m for the basement). 

� In the "Name" field, define the name of the level (e.g. ground floor). 

� In the "File" field, define the path and the name of the relevant DWG drawing file, only 
if you refer to an already existing drawing (which means that you do not intend to draw 
the ground plan from the start). If there is no DWG architectural drawing available, 
leave the filename blank.  

The insertion and the management of ground plans are performed with use of the xref 
command. At the bottom of the dialog box there are four functions available which are 
actually used to manage the floor files. More specifically: 

� Press the “New” button to save a new floor or the changes in the data of a floor (e.g. 
level, dwg drawing).  

� Use the "Current" option to select the ground plan/file you want to work on each time. 

� Select the "Delete" option to delete the floor you want (after you have selected it). The 
"Delete" command removes the ground plan of the relevant floor in the project.  

� The “Accept” command closes the dialog box (it does not save the floor data. This can 
be managed with the “New” command). FINE NGAS enables also the use of a 
“scanned” ground plan, which is a ground plan in 
a bitmap file created by a scanner. In this 
particular situation the steps to follow are 
described in detail within the User’s Guide. 

The “Layers Management” option gives you the 
choice to enable or disable in a quick and practical 
way (during working) several layers. If you want, you 
can disable any element group by simply clicking 
inside the indicator-box of the corresponding group. 
When the box is checked, the corresponding group is 
enabled.  
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The “OK” command closes the dialog box (does not save the floor data). This can be 
managed with the “New” command). FineNGAS enables also the use of a “scanned” 
ground plan, which is a ground plan in a bitmap file created by a scanner. In this particular 
situation the steps to follow are described in detail within the User’s Guide.  
The “Layers Management” option enables the user to define in a quick and very practical 
way (during working) the logical minor drawings of the ground plans (layers). If the user 
wishes, he may disable any element group, by simply clicking inside the indicator-box of 
the corresponding group. When the box is checked, the corresponding group is enabled.  

2.4.2 Drawing Walls 
AutoBLD menu contains all the commands required for drawing and editing walls, such as 
parallel moving of walls, trimming, extending, joining and breaking walls as well as placing 
openings of any kind on them (windows, sliding doors, openings, arches). During the initial 
drawing, as well as during any modification at any stage, the drawing is automatically 
updated (e.g. placing an opening on a wall does not break the wall in two parts, the 
opening moves easily from side to side whether you are working on the ground-plan or on 
a 3D view and the wall is restored without leaving undesirable lines after deleting an 
opening etc.).   

The Wall option, located at the second subgroup of the AutoBLD group of commands, 
includes the Outer, Inner, Outer wall from 
polyline, Inner wall from polyline and Outline 
options as well as the option subgroup Modify, 
Delete, Extend, Break, Join, Trim and Move. 
The first subgroup concerns the wall drawing, 
while the second their further processing after 
being drawn. By selecting Outer Wall, first of all 
its attribute dialog appears with a series of 
parameters (type, dimensions, colours etc.), 
which are described in detail within the User’s 
Guide.  

In order to start drawing a wall, you click OK 
and then follow the instructions shown below: 
Outer wall (straight / arc): After activating the 
command (by pressing <Enter> in the menu), 
you are required to successively provide: 

i) The starting point of the wall (the application message in the command prompt is: ‘’Wall 
start \ Relative to wall \ Toggle shape <Linear>’’) 

ii) The ending point of the wall (the application message in the command prompt is ‘’Wall 
end \ Relative to wall \ Toggle shape <Linear>’’) 

iii) The direction towards which the wall shall grow, by providing any point on one of the 
two half-planes defined by the wall line (the application message in the command prompt 
is "Enter Side Point"). 

FINE NGAS - 13 - 



 
 

 
After the above actions, you can see that the wall has been drawn and that you can 
continue to draw another wall starting from the ending point you defined earlier, unless 
you right click, which means that you want to stop (or press <ENTER>). You can change 
the wall drawing from linear into circular, by typing T in the following program prompts and 
pressing <Enter>. During drawing, one can come to the conclusion that the ability of 
drawing consecutive walls is very convenient since it prevents you from making many 
movements. As mentioned further below, in the “Element Parameters” section, the 
thickness of the wall, its height and its level in relation to the floor level (when the level is 
0, the wall starts from the floor), are stored within the “Element Parameters” for the wall. 
By providing proper values for the wall height and level, any possible case of walls of 
unequal height can be dealt with. The techniques and tools for creating walls are 
described in detail within the User’s Guide. 

Further to the drawing functions, the program also provides powerful editing tools, such as 
erase, modify (through the wall dialog box), multiple change etc.. Within the User’s Guide 
there are complete instructions regarding the above commands plus the applicable 
commands Copy, Stretch, Extend, Trim, Break, Unify, Mirror, Rotate, Scale, Base point. 
Two other commands that are widely used while drawing the walls are a) the Undo 
command, which enables you to reverse the previous command executed and b) the 
Properties command, which enables you to view (and change) the attributes of the 
selected wall.  

2.4.3 Drawing Openings 
Once the command "Opening" is activated, a second option menu is displayed, including 
a variety of opening types (window, sliding door, door etc) to draw, plus also a set of 
editing functions such as "Erase", "Modify" or "Move", applied to existing openings.  

Window: The option "Window" asks you to select the wall on which the opening will be 
placed and then define the beginning and the end of the opening (all these actions are 
carried out using the mouse and pressing <Enter> each time). The window will 
automatically obtain the data that are predefined in the “Element parameters”, namely the 
corresponding values for the height, the rise, the coefficient k etc.). Of course, you can 
draw the window from the ground plan as well as in the three-dimensional (3D) view. 
During drawing a window, it is very helpful the fact that, after the wall where the window 
will be automatically placed is selected, the distance from the wall edge is displayed in the 
co-ordinate’s position on the top of the screen, while the crosshair is transferred parallel to 
the wall for supervision reasons. The measurement starting point (distance 0) as well as 
the side (internal or external) is defined by which one of the two edges is closer and which 
side was "grabbed" during the wall selection. Similar functionality exists for other types of 
openings, such as Sliding Doors, Doors, Openings etc.. All the details are included within 
the User’s Guide. 
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2.4.4 Other Entities 
AutoBLD provides tools for designing columns and other elements, as well as drawing 
libraries including drawings and symbols to place within the drawing (i.e. general symbols, 
furniture, plants etc.). Details are shown within the User Guide of FINE NGAS. 

Finally, the Building model of a FINE NGAS project can be viewed through the 
commands: 

� Plan View (2D): The two-dimensional plan view of the respective building level is 
shown. 

� 3D View: A three-dimensional supervision of the ground plan of the current floor (with 
given viewing angles) is shown.  

� Axonometric: Provides three-dimensional supervision of the whole building (for all 
floors), with the given viewing angles as they have been selected in "Viewing 
Features". 

2.5 AutoNET: Network Drawing Principles  
The option group AutoNET includes all those tools the designer needs in order to draw 
(and then calculate) the Gas installation. More specifically, the main AutoNET instructions 
are described below: 

Drawing Definition: Layers for each installation are organized properly and the 
information is shown on the respective dialog. The command "Color" is used to assign the 
desired color to each network while the command "Linetype" is used to select the desired 
line type.  

Copy network of Level: AutoNET enables copying of typical (installation) plan views and 
pasting them on other floors through this command, which functions similarly to the “copy 
level” AutoBLD option. 

The basic principles and rules for drawing a network are described below: 

Network Drawing: The installation network drawing is carried out with a single line, by 
drawing lines and connecting them to each other, exactly as the network is connected in 
fact. The user should keep in mind some general principles regarding drawing and 
connecting between straight or curved, horizontal or vertical network branches.  

Horizontal & Vertical Piping: In any case, the piping drawing is carried out exactly as the 
line drawing (in Autocad or 4MCAD). The user is able to draw horizontal or vertical 
network branches. Note that vertical branches are different from columns, which will be 
described below, as they are within the borders of the active floor and do not "cross" floors 
like columns. The pipe installation elevation is the current elevation. Modification of the 
pipe installation elevation is possible through the command "elev". If you type "elev" (in 
the command line), you are prompted to determine the new current elevation. Press 
<Enter> if it is 0 or type 0 if there is another value but 0. At this point it should be 
emphasized that, if a horizontal piping which is found on a specific level is drawn and it is 
connected to another piping or a contact point (receptor), the program automatically 
"elevates" or "lowers" the pipe so that connecting to the other pipe or receptor, 
respectively, is possible. In this way, the program facilitates the drawing of piping in three 
dimensions while the designer is actually working in a two-dimension environment. In any 
case of a network design, all facilities provided by AutoCAD can be utilized through 
relative co-ordinates. 
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Column Drawing: Drawing vertical branches which cross floors (one or more) is possible 
through the option "Main vertical pipes (Building)". When the respective option is selected 
from the menu, the program asks for the column position ("Enter xy Location") and then 
for the height of the starting point ("Enter Height for First Point") as well as the height of 
the ending point ("Enter Height for Second Point"). For example, if you want to draw a 
vertical branch (column) from 0 to 3, by inserting the location point (XY) and then the 
numbers 0 and 3 successively, the symbol for direction change appears on the ground 
plan and in 3D View. 

Vertical sections within the same floor: If you want to elevate or lower a pipe within the 
same floor, you can use the relative 
coordinates. For example, if you have 
drawn a horizontal pipe (in elevation of 0 
m) and you want to elevate it to 2 m, 
when in the command line asks for “Enter 
next point”, you will type @0,0,2 and 
continue drawing the pipe (see the 
adjacent photo). In the same way, if you 
want to lower the pipe by 2 m, you will 
type @0,0,-2.  
Drawing of Curved Pipes: You can draw 
curved pipes by selecting the command and inserting the points from which the curved 
pipe is to pass (give at least 3 points). The respective command prompts for the following: 

� First point: Insert the starting point of the pipe. 

� Next point: Insert next point, the one after that and so on (successively), defining the 
pipe routing in this way and to stop press <ENTER> or right click of the mouse. 

You can easily modify curved pipes using “grips". As soon as the pipe is selected, grips 
appear which you can move, altering in this way the pipe routing. In the Bill of Materials 
and the Calculations phase, the program will measure the pipe length precisely. 

Connecting network sections: Connections between network sections (horizontal, 
vertical or both) as well as between network parts and appliances can be easily executed 
by using the "Snap" commands. For example, suppose that the two horizontal parts of the 
ground plan below, which are placed in different heights, have to be connected. If you 
start by "grabbing" the "upper" pipe end and then end up at the "lower" pipe end, the result 
in the three-dimension representation will be as on the right. 
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Special Commands for Pipe Construction: This is actually a set of commands aiming 
at the facilitated drawing of the installation piping. More specifically, there are two basic 
commands: 

� Multiple supply pipes: Multiple supply pipes can be drawn, when the in between 
distance is known, by simply defining the routing. 

� Pipe parallel to Wall: A pipe parallel to the wall (walls) that you mark is drawn, with a 
given distance from the wall, in printing mm (which depends on the printing scale as 
well). The program asks for the first point and afterwards the wall or the walls 
(successively) parallel to which (in a certain fixed distance) the pipe is to be drawn.  

� Pipe parallel to Points: A pipe is drawn parallel to the points you defined (supported 
by automatic snap), with a given distance from the crooked line defined by these 
points. The program asks for the first point and then for the other points (successively) 
parallel to which it is desired to have the pipe drawn. When all points are inserted (and 
you right click), the distance will be requested. 

� Pipe parallel to Wall (or Points) and Receptor Connection: This is a particularly 
useful command similar to the two commands above "Pipe parallel to wall" and "Pipe 
parallel to points", which, however, enables selecting the receptors to be connected on 
the routing which will be drawn parallel to the walls or the points. Therefore, it is 
possible to connect a whole set of appliances to the nearest vertical or horizontal pipe, 
with 2-3 moves.  

For better understanding of the command function, assume that in a given room with its 
appliances it is desired to install a pipe parallel to the wall and connect the appliances to 
it. The steps are the following: 

� Select the "Pipe parallel to points and receptor connection" command and the 
following options will appear:  

� Select receptors: Select the appliances to be connected to the pipe applied in a 
parallel arrangement against the wall by defining certain points on the wall. 

� Enter the first point & Enter the next point: Provide the points parallel to which you 
want to install the pipe. The points are shown on the drawing with an X. 

� Distance from a point <1.00>: Provide the distance in printing mm where the pipe is 
going to be drawn starting from the inserted points.  

The program draws the pipe and connects it to the appliances. 
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Modify an existing network: You can edit an existing network by using any CAD 
command (i.e. copy, move or erase etc. of a network section) or utility (i.e. grips) during 
the design process. The only rules to apply are the following: Pipes supplying the 
appliances should be connected to the touch points of these receptors. Obviously only 
one pipe can be connected to a touch point. The connection with the touch points which 
appear as red "stars" in the ground plan can be executed with the "esnap" function. Piping 
can be branched to one another and extend in any way as long as they do not form loops, 
something which does not apply to reality anyway. If however a mistake occurs, the 
program (during the recognition procedure) will perform all checks and indicate the 
mistake and its location. A necessary step before the "Network recognition” is defining the 
point (1) where the network starts, that is the “supply point”. In FINE NGAS application, 
the menu includes the specific options, so that you can be easily guided when drawing 
any installation.  

Placing the receptors: Placing a receptor can be done simply through the following 
steps:  

� Select a receptor (from AutoNET->Receptors) and press "OK" (or alternatively double 
click). It can be observed that the receptor moves on the ground plan with the graphic 
cursor.  

� If you move the mouse properly, the receptor can be carried in such a way that its 
base point (which coincides with the cross of the graphic cursor) can be placed in the 
desired point. Right click or <ENTER> to confirm your selection. 

� If you move the mouse again, the receptor will rotate around the base point. Thus, if 
you confirm the angle in which you want to place the receptor (again by right clicking), 
the receptor "freezes" in its final position.  

You can also insert and place either the whole receptor or only its touch points in the 
ground plan by checking one of the two options in the upper part of “Receptors” window. 
This is important when an existing ground plan includes drawn receptors and there is no 
need to redraw them, but just move the touch points so that the information for the 
respective supplies will be available.  

Regarding the installation height of a receptor, it should be pointed out that receptors are 
always installed in the current height. The current height can be changed with the "Set 
elevation" command (from the PLUS menu). 

Fittings: The "Fittings" command selects the 
accessories to be also inserted in the drawings, which 
applies exactly the same to the receptors. Fittings have 
"touch points" upon which the piping will be connected 
so that the network can be identified. A symbol may 
also have more than one touch points (e.g. a shut-off 
cock), in which case the accessory will be numbered as 
a junction point in the "Network Recognition". The 
program provides the capability of cutting off the line 
automatically when a symbol is inserted on the line, 
exactly where the accessory interjects. This capability is 
defined by the indication of the accessories box "Brake 
Pipe". If this option is activated, then the program will 
automatically "Break" the pipe when the accessory is 
placed. Moreover, the "Move Symbol" indication is in the same box, which defines 
whether the accessory will be moved in relation to the position it was initially placed (so 
that it will be placed parallel and on top of the pipe) or the pipe will be moved (so that the 
accessory can be attached).  
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Symbols: "Symbols" include various general symbols and other drawings that can be 
used in the corresponding installation. 

Network Recognition and Numbering: Since the network has been drawn according to 
the current rules and the supply point has been determined, the "Network Recognition" 
option converts the network in the required standard pattern and updates appropriately 
the calculation sheets. During updating, junction points and receptors are numbered on 
the ground plan. Note that if a receptor is not numbered, means that the receptor is not 
connected to the network. Besides, if a network section has a different color it cannot be 
connected to the network. Connect it or select "Break at selected point" at the connection 
point with the previous pipe.  

Calculations: The "Calculations" option leads you in the corresponding calculating 
environment (ADAPT/FCALC), which means that the window of the current application is 
“opening”, while FINE NGAS remains "open". In order to transfer the data from the 
drawings, you should select "Update from Drawing" in the "Files" menu of the 
corresponding calculating application (in order to carry out the corresponding calculations, 
answer "Yes" to the question "Calculate" that appears). From now on, apply all the 
capabilities mentioned in the ADAPT/FCALC User's Guide for the respective application. It 
has to be noticed that the numbering of the sections, the lengths of the network sections, 
the receptors with their supplies and the accessories (from the piping routing) are 
transferred in the calculation sheet. Of course, if the user wants to, he can intervene in the 
calculations in order to make any modifications.  

Legend: The "Legend" option creates a legend with all the symbols that have been used 
in this specific project. By selecting it, the program asks for the location where the legend 
is going to be inserted. Use the mouse to define the location and the legend will appear 
automatically on your screen, exactly under the location point.  

Vertical Diagram: This option is used for the automatic creation of the vertical diagram of 
the installation and in its appearance on the screen, within a few seconds. In case there is 
already a vertical diagram, the program asks if you want to update it. It is obvious that, in 
order to create a vertical diagram, you should draw and identify a network and enter the 
calculation sheets, so that the program knows all the data needed for the vertical diagram 
creation (pipe dimensions, junction points numbering, etc).  

 
By the “creation” command the window of the vertical diagram’s manager appears on 
screen. This window is composed of two parts, the part with the network tree and the part 
with the vertical diagram. Through appropriate commands, the user can intervene in 
several ways on the output of the diagram: 

� Enable or disable various branches of the network 

� Change the order of the columns of sub-networks in the vertical diagram 
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� Change the sub-networks direction connection on the vertical columns (right or left) 

� Read the information of each node 

� Describe the sub-networks 

The changes done in the vertical diagram with the help of the above icons are displayed in 
real time, in the second part of the window. On the upper side of this window there are 
also icons for processing the diagram (real time zoom and pan, zoom extends etc). In 
addition, in the upper-left side there are some other icons having to do with the 
appearance of the screen, such as the hiding of the left part of the window, the 
appearance of the level names and  heights on the left to be edited, the appearance of the 
numbers of the receptors, the layers and others. 

Finally there are some options for the initialization 
of the vertical diagram, its recreation and the 
definition of the drawing parameters. In particular, 
these parameters include the following options: 

Layers: Through a supervisory window table, the 
user can define the drawing scale, the colors 
corresponding to the various layers and the height 
of the texts (in mm drawn on paper) placed on the 
vertical diagram. 

Drawing dimensions: The drawing dimensions 
that will be considered on the creation of the diagram are also defined on mm drawn on 
paper. 

Blocks: There can be defined on each application different network starting points and 
type of tables. The user can choose from a set of dwg drawings. 

Others: A set of attributes concerning the form of the vertical diagram is defined, such as 
the condensation of the columns, the number of branches over whom the node is 
considered as collector, whether the z height information will be considered in the diagram 
creation and whether the sub-networks pipes on the vertical diagram will be placed over 
or under the receptors. Finally, it should be mentioned that during the editing procedure 
concerning the vertical diagram manager, if there are mistakes the program displays the 
proper messages and warnings. 

Library Management: The Library Manager leads to a submenu including the options 
"Numerical data" and "Drawing data". The first option leads to the libraries with all the 
numerical data of the materials. The "Drawings" option leads to a dialog box where the 
following data can be seen, regarding each application. 

2.6 AutoNET: FINE NGAS Installation 
The previous chapter described the drawing principles, while this one describes those 
commands in relation to the special features of FINE NGAS.  

Regardless of the fact if there is an AutoBLD building model, an external reference, a 
digital image or even no architectural drawings, a gas installation can be drawn and then 
calculated. 

Although there are no limitations regarding the order of actions followed in drawing an 
installation, the following order is suggested: 

� Place the receptors (Gas stove, gas-fired water heater etc.) 
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� Draw the horizontal pipes 

� Connect the receptors to the pipes 

� Draw the vertical pipes (if needed) 

� Connect the horizontal to the vertical pipes 

� Define the Supply point(s) 

� Place the chimney(s) 

� Assign the appliances to the chimneys 

� Run “Network Recognition” 

� If there are no mistake messages, proceed to the Calculations 

Placement of the Receptors to the drawing: We select 
“Receptors” either from the AutoNET menu or from the “Natural 
Gas” toolbar.  

 
When all receptors’ window appears, select the type of the 
receptor, which will be placed at the specific point. 

 
The gas receptors are placed as referred earlier. In case they already exist on the 
architectural plan view, then we just click at the “Touch points only” field. 

Receptors Data: This is a useful command that gives you the ability to place easily a 
legend with information for each receptor. When you select the command, the program 
asks you to choose the receptor and automatically places its data on the drawing.  

Aeration legend: With this command you can place 
an aeration legend for the boiler room, the gas stove 
and the water heater. In order to place it, first you 
have to define the space by giving two points, one 
internal and one external, select the openings of the 
space (for the boiler room and the water heater) and 
finally select the location of the legend. Automatically 
a legend with detailed information of the space is shown and the program checks if the 
airing requirements are met.  
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Chimneys-uptakes: When the network has been drawn, the chimneys have to be placed 
in order to be transferred to the calculations. The 
program provides the following options: 

- Orthogonal/circular chimney: Select one of the two 
types, click on the location where the chimney will be 
placed, define the elevations of the starting and the 
ending points (e.g. from 3 m to 10 m) and press 
<Enter>. Automatically the chimney with its number is placed on the drawing.  

- Modify chimney: If you want to make changes in the chimney, with this command you 
select the chimney and automatically the data window appears. 

- Assign chimney to the receptor: In order to assign an appliance to a chimney, select 
the appliance, press <Enter> and in the command line type the number of the chimney 
on which will be assigned. 

- Uptake: If you want, with this command you can design a drawing for the uptake 
(connecting flue pipe) that connects the appliance to the chimney.  Select the 
command and in the window that opens define the uptake’s characteristics (width, 
hatch etc.) and press either “Points” or “Polyline”: 

• Points: Click on several points highlighting the shape of the uptake (starting point, 
middle ones and ending point) and when you press <Enter> define the “side point” 
which will be on one of the two sides of the line that has been created. 

• Polyline: Select the polyline you have already drawn (from Draw > Polyline menu) 
and when you press <Enter> define the “side point” which will be on one of the two 
sides of the line that has been created. 

- Modify uptake: If you want to make changes in the uptake, with this command you 
select the uptake and automatically the data window appears. 

Placement of the Fittings to the drawing: We select 
“Fittings” either from the AutoNet menu or from the 
“Natural gas” toolbar. In the window that appears, 
select the type of fitting, which will be placed at the 
specific point (detailed information in paragraph 2.5). 

Horizontal networks design: After you place the 
appliances, as described earlier, you proceed with the 
design of the vertical and horizontal pipes of the level. 
After the design of the vertical and horizontal pipes, 
you connect the pipes to the receptors. For the 
reduction of both the time needed for the specific work 
and of the errors we suggest the use of the “Connect 
receptors to existing pipe” command. When you select it, the program asks you to 
define the appliance(s) which will be connected to a specific part of the pipe, then the pipe 
and when you press <Enter> they are automatically connected. 

Design of the networks’ Vertical pipes: You draw the vertical pipe as it was described 
in the previous chapter, giving the pipe position, the starting and the ending points. We 
must point out that the heights of the vertical pipes are dependent upon the level heights 
of the building that you defined in “Building definition”. All pipes will be connected to the 
vertical pipes through the “Perpendicular” snap point.  

Set of Supply Point(s): From the edge of the vertical pipes connect the horizontal pipes, 
and place the supply point to the end of it. It is important to use the Endpoint snap to 
connect the supply point to the horizontal pipe. 
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Network recognition: Select “Network recognition”, in order for AutoNET to recognize 
the network and prepare the files for the connection with the calculations. During the 
recognition, messages warn you for potential drawing errors. For example there might be 
closed routes of the horizontal pipes, points at which different types of pipes end, lack or 
false placement of the supply point, elements unconnected etc. Besides, no “white” parts 
should appear on the network, which means that they haven’t been “recognized”. As soon 
as you correct them, run again the “Network recognition” and if there are no mistake 
messages, proceed to the calculations. 

Calculations: When the control is completed we’re ready to proceed to the computing 
environment. By selecting “Calculations” the Natural Gas calculations are displayed in a 
new window. When select “Files” and “Update from drawing”, the data is transferred at the 
calculation sheet.  

Update Drawing: After the calculation part of the program is completed, save the project 
file, return to the drawing program (FINE NGAS) and select “Update Drawing”. The 
following window will open and you will select the information you want to be shown on 
the drawing. Particularly: 

- In the left part of the window, you select the information you want to be shown 
regarding the pipes. You can select to see information for all the pipes (choose 
“Select All”), some of them (choose “Select from Drawing” and select the pipes from 
the drawing) or none (choose “Deselect All”). Furthermore, below this list, you can 
choose which information you want to be shown, such as the length, the flow rate, the 
diameter etc. If you do not want, for example, the “Velocity” to be shown, select it and 
uncheck the “Selection” button. 

- In the right part of the window, you select the information you want to be shown 
regarding the receptors. You can select to see information for all the receptors 
(choose “Select All”), some of them (choose “Select from Drawing” and select the 
receptors from the drawing) or none (choose “Deselect All”). Furthermore, below this 
list, you can choose which information you want to be shown, such as the receptor 
name, the flow rate etc. If you do not want, for example, the “Type” to be shown, select 
it and uncheck the “Selection” button. 

Finally, to place the information on the drawing, select either “Manually placement” or 
“Auto Placement” (the program automatically chooses to place the information for each 
pipe and receptor in the best position without covering each other). 
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You can easily move the position of the data on the drawing selecting “Move drawing 
update Data” (from the AutoNET menu) or change their height and style from the “Space 
text style” command (from the AutoBLD -> Element parameters) and run “Update drawing” 
again.  

Convert single line to 3D: This command converts the single line pipes of the drawing to 
3D. The diameter of the 3D pipes is directly related to the calculation results and 
therefore, before you run this command, you have to update the drawing.   

Axonometric Drawing: The axonometric drawing is produced automatically with the use 
of FINE NGAS provided that the network was designed at the specific program. From 
AutoNET we select “Axonometric Drawing” > “Create”. Then the following window 
appears. 

 
Detailed information for the axonometric diagram parameters are given in paragraph 2.5. 
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Vertical Diagram: The vertical diagram is produced automatically with the use of FINE 
NGAS provided that the network was designed at the specific program. From AutoNET we 
select “Vertical diagram” > “Create”. Then the following window appears: 

 
You can apply all the desired changes as it was described in the previous chapter or close 
the window, which will result to the display of the design in a DWG form, which you can 
modify using the provisions of CAD programs.  
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3. Calculations 

3.1 Introduction 
This chapter provides a description of the Calculations Component of FineNGAS. This 
module can be used either independently, by filling the numeric data, or in co-operation 
with the CAD component of FineNGAS, in which case the calculation environment 
acquires the data directly from the drawings. 

 
At the top of the application window appear the general options of each application menu, 
constituted of the group options "Files", "Project Data", "View", “Windows”, 
"Libraries" and "Help".  

The core of the calculations is the calculation sheet, a spreadsheet-like environment with 
specific capabilities and facilities tailor-made for each application. More specifically, 
regarding FineNGAS, which refer to an installation network, the calculation sheet is shown 
in a spread sheet using lines corresponding to the network branches, and columns 
containing primary data (e.g. pipe length) and results of calculations (e.g. gas velocity) for 
each branch. An example of such a sheet for the GAS Application is shown below: 
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In order to make the network understandable by the program, a specific standardization 
should be followed, which is more or less the same in all applications. The standardization 
becomes easily understood with the following simple example. 

Suppose we have the network shown in the 
adjacent figure. This network comprises several 
branches (i.e. parts of the network), junction 
points and terminals (end points). Thus in this 
network, we have assigned arbitrary numbers to 
both the junction points (1,2,3) and the hydraulic 
terminals (4,5,6). Each junction point may be 
assigned a number or a letter (lower or upper 
case, e.g. A, d etc) or a combination of letters and 
numbers (e.g. A2, AB, eZ, 2C etc.). The main 
logical restriction is that in the starting point is always assigned the number 1. Also, 
assignment of the same number twice in the same network is not permitted for obvious 
reasons, with the exception of junction point 1 for which the assignment may be repeated 
as desired (for networks with more than one starting points). After numbering the junction 
points and terminals according to the above rule and in order to represent the network in 
the spread sheet, it is enough to give a name to the various sections of the network 
entered in the first column of the spread sheet. Having in mind that the order of network 
sections is not important, we fill in the first column with the two junction points of each 
section (putting a dot in between) so that the sequence of junction points matches the 
direction of gas flow in the pipe. In the above example the sections 1.2, 2.3, 2.6, 3.4 and 
3.5 should be filled in (order is arbitrary). In some other columns of the row we fill in a 
series of data (e.g. length of section, fittings included in the section etc.) which depend on 
the type of installation while the output resulting from calculations and updating the 
remaining columns depend also on the particular installation.  

Taking as a reference point the above spread sheet and ignoring initially the filled in 
values, we can see the columns heading zone (every column has its title and units), the 
zone for filling in values with a number of rows (separated with dotted lines for better 
supervision and clarity) and a status bar where helpful information appear depending on 
the position in the spread sheet we are in. Since the spread sheet contains usually a lot of 
information and is the core of the calculations in each application, it is particularly useful to 
have it maximized on screen by clicking on the upper arrow (located at top right of the 
window), so that the whole computer screen area is utilized.  

The next section will familiarize you with the “Calculation Sheet”. The Calculation Sheet 
provides its user with all the editing functions, which are described below: 

First of all, the user has the possibility, as stated earlier, to use in the frames where the 
Calculation Sheets appear the "Font" option for both the calculations zone (so that 
values appear with the desired size and style) and the headings zone (so that headings 
are shown to the user satisfaction). 

As far as the headings zone is concerned, the user can also increase or decrease the 
column width using the mouse: As long as the mouse pointer rests on the vertical line 
separating two adjacent columns, it takes the form of a double arrow and then by pressing 
(and keeping pressed) the left mouse button and dragging, the column width is increased 
or decreased depending on the direction of mouse movement.  

The above alternative supervision possibilities available to the user depend on several 
factors such as the resolution of the graphics card and screen size, and for this reason 
any possible interventions are left to the user discretion. For that matter, there is also the 
possibility of “Load Prototype” from the user. Note however, that best supervision results 
are achieved with higher resolutions and large screens..
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Access to the positions of the zone for filling in values is carried out with the use of the 
mouse and the arrow keys of the keyboard. Moving the mouse pointer in the zone for 
filling in values we can see that in some columns the pointer takes the form of a vertical 
line (|) while in other columns it takes the form of a prohibitive traffic sign. We cannot 
modify the values contained in these last columns (because they result from calculations). 

If we move the mouse pointer (having the form of a cross) in to a cell or small square and 
click the left mouse button, we’ll see that the cell contour (outline) becomes dark and we 
can fill in a value or modify the cell content. In the same way we can move to any other 
cell, or using  the <Enter> key we move to the next cell below and using the <Tab> key 
we move to the next cell at the right and so on. Besides, in case the window width is not 
large enough to accommodate all columns, we can review the entire calculation sheet by 
manipulating it up-down or left-right using the vertically or horizontally sliding keys 
(potentiometer like). In addition, when access to a column for filling values is denied, the 
mouse pointer takes the form of a prohibitive traffic sign. This way, the user is informed 
that the quantity under examination is a derivative one i.e. resulted automatically from 
calculations.  

The user should keep in mind the following useful commands when entering values in 
the Calculation Sheets of any application: 

Deleting cell content: Pressing the <Del> key on a cell, the value it contains is deleted, 
and the cell is blank. 

Deleting a row: Pressing the keys <Ctrl>&<Del> in combination, the row we are in is 
deleted. 

Inserting a row: Pressing the keys <Ctrl>&<Ins> in combination, a new (blank) row is 
inserted immediately below the cell we are in. 

Moving to the beginning of a row: Pressing the <Ηome> key, we move automatically to 
the first column of the row we are in. 

Moving to the end of a row: Pressing the <End> key, we move automatically to the last 
column of the row we are in. 

Moving to the upper part of the sheet (first column-first row): Pressing the keys 
<Ctrl>&<PgUp> in combination, we automatically move in the first column-first row of the 
calculation sheet. 

Moving to the lower part of the sheet (first column-last row): Pressing the keys 
<Ctrl>&<PgDn> in combination, we automatically move in the last row of the calculation 
sheet. 

Finally, you can move from an upper to a lower cell using the <Enter> key and from a 
left cell to a right cell using the <Tab> key. 
In addition, the calculation sheet provides the user with a set of Spreadsheet Functions, 
which are available in most windows applications, such as the Cut-Copy-Paste type of 
commands of a subset of lines (or even the whole calculation sheet), the row and columns 
width definition, the font type (as well as font attributes, justification etc) of a selected 
area, and so on. By selecting a certain area of the sheet (or all of it by “select all”) and 
then pressing the right button of the mouse, a small menu appears on screen, with the 
relative commands. Another useful command is the Undo/Redo command concerning the 
calculations. All those editing commands are also applied to other windows. Apart from 
the copy-paste command, in case we want to repeat a row (typical branch), it is sufficient 
to fill in the content of the first column, i.e. the section name, that will make a copy of the 
row except for the section name which remains blank.  

FINE NGAS  - 29- 



 
 

When the calculation sheet is activated, you will see in the main menu options an 
additional one namely “Calculation Sheet” with a secondary option “Printing Parameters”. 
Selecting “Printing Parameters” the adjacent dialog box appears from where the user may 
affect the appearance of the printed Calculation Sheet. Specifically, the user may define a 
bold outline (frame), a normal outline, or no outline, horizontal and/or vertical lines, as well 
as a raster for the titles (headings) of the spread sheet with the desired shading of tints 
(using the sliding key). As previously emphasized, the Calculation Sheet window is the 
core for all applications. Since, however, not all calculation results related to a study can 
be confined within the Calculation Sheet, every application has additional windows where 
these complementary results are accommodated to form the complete set of the study. 
The advisability and functional description of these windows is the subject matter of each 
application. For all that, we can pick out, among the available windows, some of them with 
common philosophy regardless of application (e.g. ‘’Bill of Μaterial – Costing’’ Window, 
‘’Technical Description’’ Window etc.). The “forms” of these windows are described in the 
following sections not necessarily in the order found in the applications. 

3.2 Main Menu 
If you want the GAS network application to be executed, point with the mouse and double 
click on the relevant icon, and the main menu window will appear: 

 
As you can see, the basic menu options are divided into the groups "Files", "Project 
Data", "View", “Windows”, "Libraries" and "Help", which are described below along 
with their secondary options. 

3.3 Files 
The "Files" option includes the usual file management options according to the windows 
standards: 

New project: Type a name for the new project you want to be saved in a file. 

Select project: A window appears where you can select the desired (existing) project file 
and load it. 
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Caution! If neither a new nor an existing project is selected, the programme automatically 
considers that the UNNAMED project is active. If you add new data to the UNNAMED 
project and you want to save it with a different name, select “Save as” and type the new 
project name. 

Update from Drawing: In the case of co-operation with the FINE package, the project 
calculation sheets are updated with the drawing data. 

Caution! If the option "Update from Drawing" is selected, without previously opening a 
project and inserting rooms in the ground-plans using the FINE package, any existing data 
in the calculation sheets will be replaced with blanks. 

Save Project: The project you are currently working on is saved to the hard disc (with the 
previously given name). 

Save Project as: The project you are currently working on is saved in a different file with 
a new name. 

Load Prototype: The saved prototype appears on the screen. 

Save as Prototype: The form, which has been created by the user and is displayed on 
the screen when this option is selected, is saved as a Prototype. 

Printing Prototypes: The printing prototype management window is activated. 

Printing: The project issue is printed according to the previously selected options in 
"Printing Contents" and "Printing Parameters" as well as according to the print preview 
output. 

Printing Contents: You can select the project items you want to be printed: 

Printing Parameters: The desired printing parameters can be selected in this window. 

Print Preview: The complete project issue appears on the screen, exactly as it will be 
printed, page to page. 

Export to RTF: An rtf file, containing the project items, is created (within the project 
directory, with the name KAER.RTF). 

Link to WORD: A .doc file, containing the project items, is created (within the project 
directory, with the name KAER.DOC). At the same time, the MS-Word application is 
activated (if it is installed in your PC). 

Link to 4M editor: An rtf file, containing the project items, is created (within the project 
directory, with the name KAER.RTF). At the same time, the 4Μ text editor is activated for 
further editing.  

Link to Excel: An xls file, containing the project items, is created (within the project 
directory, with the name KAER.xls).  

Export to PDF: A pdf file, containing the project items, is created (within the project 
directory, with the name KAER.pdf).  

Exit: Exit from the application. 

3.4 Data 
This is about the basic project data, which are divided into “Project Info” (project headings) 
and “Network” data. The “Project info” refers to titles and headings related to the project 
identity, while the “Network” option refers to the general network data that the project 
designer should specify and are related to: 
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Equipment schedules GI type: The equipment schedule of the appliances of GI type is 
entered in this field. The “GI” refers to gas-fired appliances that are commercially or 
industrially used. 

Gas Category: The gas category corresponding to the specific project should be filled. 
These are either earth natural gases, synthetic gases (SNG= Synthetic Natural Gas), or 
their alternative gases. They are divided according to the range width of the Wobbe index 
in the families L, H and E.  

Main Pipe Type: With the key <F11> or by pressing the key in the field, you can select 
from the pipe library window that appears, the pipe type which shall be used in the project 
(e.g. Copper pipe) 

Main Pipe Standards: The standard corresponded to the main pipe must be defined. 
Main Pipe Roughness Factor (μm): The above selected pipe roughness appears 
automatically (μm) but it can be modified from this field. 

Secondary Pipe Type: The type of the secondary pipe should be selected, following the 
instructions provided above for the main pipe type. 

Secondary Pipe Standards: The standard corresponded to the secondary pipe must be 
defined. 
Secondary Pipe Roughness Factor (μm): The above selected pipe roughness appears 
automatically (μm) but it can be modified from this field. 

Maximum air velocity: It is the maximum air velocity based on which the cross-sections 
are calculated. That is to say the smallest possible cross-section, for which the velocity 
does not exceed this value, shall be selected. This value can be modified here as a whole 
from the user (and it shall be applicable in every part of the network), and also within the 
calculations sheet, in the “Max velocity” column. 

Number of chimneys: The total number of chimneys should be filled. The user can fill 
from just one (1) up to twenty (20) chimneys in a project.  

Operation Pressure: The operation pressure of the network should be filled with 
maximum value of 0,1 bar (100 mbar). Usually the default value is equal to 0,02 bar. 
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Operating Temperature: The operation temperature of the network should be filled in ºC. 
The default value is equal to 15 ºC.  

Building height above sea level: This height in meters should be filled with respect to 
the sea level and is necessary for the chimney calculation according to EΝ 13384.01 
standard. 

Import data from the Vertical Diagram: This option enables you to draw the vertical 
chart firstly with the aid of an expert system and thereafter to transfer the data in the 
calculation sheet. If the check box is checked, the option “Insert vertical” appears in the 
program menu and you can use it in order to draw the vertical chart. 

3.5 Vertical Diagram entry 
This option includes the two secondary options “Vertical Diagram Creation” and “Update 
from vertical Diagram”, which are explained in the following sections. 

3.5.1 Vertical Diagram Creation 
This option has the following secondary options: 

1. Diagram type 
• Receptors > Transfer as simple receptors 
It is specified whether each receptor is defined separately in the vertical diagram or if it will 
be integrated in a receptor group. In case that the check box is checked, the network is 
analyzed thoroughly in nodes. 

2. Building parameters 
If you select the building in the upper left part of the screen, the building data will appear. 

The topology of the building as well as the layout of the installation network in it is 
included in the building data. In the box “Building options” the levels with gas consumption 
are checked. In particular, if you select the ground floor and the floors, an additional field 
will appear where the user should fill in their number. You can also define the number of 
the apartments in each floor as well as the height of each floor. 

After the user has defined the building data, he can press the key “Apply” and the building 
will appear in the left column in a tree form with an icon in front of it that shows the floor 
type. 

Working with levels 
If you click with the left mouse key on the level name, the level data “Level Name”, “Level 
Height (m)” and “Number of Apartments” appear on the right side. The user can enter the 
fields “Level Name” and “Level Height (m)” and edit the level data. 

If you double click with the left mouse key on the level name, the floor topology with the 
apartments will appear in tree form. 

If you click with the right mouse key on the floor name, a menu with the following options 
will appear: 

• Insert new Apartment: You can insert a new apartment besides the ones that are 
defined so far. 

• Copy FLOOR: Copies in the PC memory (clipboard) the floor network in order to 
paste (copy) it later on a different floor. 

FINE NGAS  - 33- 



 
 

• Paste FLOOR: Copies the network data that are saved in the clipboard to the selected 
floor. The data that are already entered in the floor shall be overwritten by the new data. 

Working with apartments 
If you double click on the floor the apartments will appear and in the right side will appear 
the option “Insert space with Gas”, where a list with various room types will be shown. If 
you double click on each room the room drawing will appear underneath it. If you double 
click on the desired room, this will be transferred automatically in the apartment selected 
in the left column. In the same way you can add more rooms in the same apartment or in 
different apartments. 

If you right click on an apartment room the list shown in the next window will appear, with 
which you can manage the rooms: 

• The command “Delete“, deletes a room. 

• The commands “Move upwards” and “Move downwards” alter the order of the room 
inside the apartment. 

• If you click with the left mouse key on an apartment room the room drawing will be 
shown enlarged.  

3. Network data 
In the option connections you can see the network structure from the gas network until 
each apartment. In this option, the user can manage the gas consumptions. At first, there 
is a separate gas installation for every apartment. If for example, there are two apartments 
in the building with common ownership, which are located in different floors, then the user 
can transfer the gas network from a column to a different one, to delete a column or a 
certain flow gauge. This is achieved by right clicking on an element. Depending on the 
''tree'' element on the left side of the window that you right click, a menu appears which 
enables you to move or delete or even add an element. Hence, the user is able to modify 
the network as it is desired. 

4. Diagram 
With this option, the vertical chart of the previously mentioned installation appears. 
Moreover, you can change the colors that appear in the chart.  

3.5.2 Update from vertical diagram 
This command is used to transfer the network data in the vertical chart in the “Calculation 
sheet”.  

3.6 View 
This option includes the secondary option "Toolbars" and follows in general the windows 
standards. 

3.7 Windows 
The option “Windows” includes a series of calculation and result windows, in which the 
analytical project calculations are presented. The main window which comprises the core 
of the application calculations is the Calculation Sheet, and is described in the following 
section. 
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3.7.1 Cover Page 
The “Cover page” window is the first printed page of the project and you can select 
among different types of cover pages or even create your own, exactly as you want it. 

To load or create a different cover page, in the program menu go to Cover page -> 
Prototypes, select the prototype you want and press “Load”. If you want to save the cover 
page you made and use it in other projects, in the same window enter a name and a 
number (e.g. 02 Simple Alignment) and choose “Save as”. 

Note:  The cover page files are stored in \CALC\KAER\ , named KAERCV01.RTF, 
KAERCV02.RTF, etc; their descriptions are stored in the file KAERCV.LST. 

3.7.2 Assumptions 
The text of the project general assumptions, which may be included in the printed project 
as long as it is selected in "Printing Contents", is stated. If the option “Assumptions” is 
selected, you can load a different prototype or create your own from the program menu 
Assumptions -> Prototypes.  

3.7.3 Systems of Appliances 
Here the receptor systems that are used in the specific project are presented and 
analyzed in the receptors constituting them. 

3.7.4 Receptors Legend 
The receptors used in the project are presented. 

3.7.5 Fitting systems 
Here the fittings systems that are used in the specific project are presented and analyzed 
in the fittings constituting them. 

3.7.6 Legend of fittings 
The fittings used in the project are presented. 

3.7.7 Calculation Sheet 
The Calculation Sheet of the GAS network is the core of the calculations for the Gas 
installation application and conforms to the general rules of the Network Calculation 
Sheets, which are described in the first section. Therefore, each row of this sheet 
corresponds to a different network section while each column refers to the data that will be 
filled-in or will ensue automatically during the procedure of completing data. Help 
instructions concerning data entering appear at the bottom of the screen (status bar). In 
each row, the fields of the first column, which refer to section designations, should be 
filled-in first of all.  

The method for the network standardization is based exactly on the standardization rules 
that were explained earlier. Here is a short description of the columns of the calculation 
sheet:  
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1. Network section: In the rows of the first column you should fill-in all the network 
sections (one section in each row) one by one. The sections are defined by their end 
nodes. You may assign a number (from 1 to 9999) or a letter (lower or upper case, e.g. 
A2, AB, 3c, Aa etc.) to each node. The basic restriction in numbering is that number 1 is 
always assigned to the point that is connected to the gas meter. Except the number "1", 
the same number should not appear in the network twice. After the numbering you can 
enter in the calculation sheet all the sections independently one by one (the sequence of 
the sections is not important), by filling-in the first column: 

In the case of typical (similar) sections it is possible to recall them (with their name from 
the first column) in order to automatically transfer them. 

2. Pipe length: You must state the pipe length in (m) in every section between two nodes 
(e.g. section 2.3). 

3. Type of appliance: If there is an appliance at the specific network section, that is to 
say if the section ends up to an appliance, you can select it from the library with the GAS 
installation appliances, after pressing the key F11 or by pressing the key inside the field in 
this column. A window will appear with the list of the appliances.  

 
The type of the appliance (hydraulic receptor) is defined when a unit is filled-in in the last 
column, in the row that corresponds to the receptor, and the key “enter” is pressed after 
that in order to validate the data entered. By pressing "OK" you can return to the 
calculation sheet where you can notice that the order number of the appliance is filled-in. 
Alternatively, except defining only one appliance, you can also define an appliance system 
with up to 10 different types of appliances in each section.  
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Since you are working with systems, the program enables you to define an order number 
of the hydraulic appliances system i in the upper part, and the relevant System appears in 
the column with the form S-i, where i represents the order number of the defined System.  

With this feature you avoid filling-in again the same appliances, since you can fill-in 
directly the order number of the System. The method with appliance systems is indicated 
in the case of very large installations, where the appliances are grouped in a few systems 
and the data volume is radically decreased in the calculation sheet. 

4. Appliance flow rate (m³/h): The appliance flow rate QR, or in general the network 
section flow rate (theoretical sum of the flow rate if all the appliances work at the same 
time) is automatically calculated. The program calculates automatically the flow rate of the 
intermediate sections based on the flow rate of the appliances that are supplied from this 
section.  

5. Peak capacity (m³/h): The peak capacity Qs is calculated based on the total capacity of 
the previous column. The peak capacity is calculated from the relevant peak curve that 
depends on the equipment schedule which has been initially selected by the user for the 
GI type of appliances, or it is loaded automatically for all the other types.  

6. Desired pipe size (mm): From this column the user can select a different diameter 
from the one that is calculated by the program (and is shown in the next column). If you 
press F11 or the key in the field, the list with the diameters of the selected in the "Network 
Data" pipe type is shown. 

 
With the option "Select" you can select the desirable diameter, and you can see the 
effects of your choice in the rest of the network parameters (e.g. velocity, friction values 
etc). If you press <Del> in the relevant component of the calculation sheet you can delete 
the desired diameter, and the program calculates again the diameter. 

7. Pipe size (mm): The pipe size of the network section, as it is calculated by the 
program, is shown in this column. 

8. Maximum velocity (m/s): The velocity limit that is defined in the "Network" (in m/s), 
which you can modify if you want for the particular network section, is shown here. You 
must keep in mind that, if you change later the general limit in the "Network" this will not 
affect the modified values, but only the initial ones (the ones that have the same value 
with the “Maximum gas velocity” which is defined in the “Network”).  

9. Gas velocity: The gas velocity in (m/s) as it is calculated in the specific network section 
is shown here.  
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10. Type of fittings: This column refers to the type of fittings (elbows, tee sections, valves 
etc) that appear in the network section. If you want to fill-in the components in detail you 
press F11 or the key in the field in this column, 
and the window with the list of the gas system 
components from the relevant library will 
appear. If only one component exists, this is 
defined by writing the number 1 in the last 
column, in the row that corresponds to the 
component. By pressing "OK" you can return to 
the calculations sheet where you can notice 
that the order number of the defined component 
is filled-in.  

For more than one component you can fill-in 
correspondingly the last column of the table 
with components, giving also the quantities of 
each component (up to 10 different types of 
components per section). In the case that you 
have more than one component, the indication 
F- appears in the column, which means in 
general "Fittings". If, in the upper part of the 
fittings table, you define a fitting system number a, the indication F-a will appear in the 
column. In this way you can group the fittings and also avoid filling-in the same groups 
(systems), since you can fill-in directly the fitting system number. 

11. Fittings friction losses (mbar): The calculated fitting friction loss for the specific 
network section in mbar is shown here.   

12. Levitation friction losses (mbar): The calculated friction loss caused by the gas 
levitation is shown here for the specific network section in mbar. In case of upward 
sections (segments) the value is negative, whereas for downward sections is positive. For 
horizontal sections it is equal to zero. The direction of a section is being defined in the 
column “pipe route”. 

13. Piping friction losses per meter (mbar/m): The calculated friction loss for the piping 
in the specific network section in mbar/m is shown here. This friction loss is calculated 
from the gas flow in the respected section, based on hydraulic calculations. 

14. Pipes friction losses (mbar): The calculated friction loss for the entire pipe in the 
specific network section in mbar is shown here. This friction loss is calculated from the 
gas flow in the section, based on hydraulic calculations. 

15. Total friction loss (mbar): The total friction loss in the section, that is to say the sum 
of the Friction of Fittings and the Friction of Piping, also in mbars is shown here. 

16. Segment permissible pressure loss (mbar): This value depends on the specific 
standards adopted.  
17. Total friction loss of the line (mbar): The respective calculated value is shown.  

18. Network permissible pressure loss (mbar): This value depends on the specific 
standards adopted.  

Following you will see the items "Polar angle", "Pipe route”, “Chimney number”, 
“Connecting flue pipe type”, “Connecting flue pipe cross section”. These items can be 
filled-in directly in the relevant columns, or from an additional window, which appears 
when you press the key F12 in any column or if you press the right mouse button and 
select from the list ''Options" that appears. The use of these columns is explained below:  
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19. Polar Angle: It is necessary to fill-in the polar angle of the network only in the case 
that you desire to draw a vertical diagram (and a rough drawing) from the calculation 
sheet, that is to say in the case that you have not drawn the ground plans with the FINE 
NGAS application. The vertical diagram that is drawn takes into consideration the length 
and the polar angle (in relation to the horizontal axis) of each branch.  

20. Pipe passing (upwards - descending): This field is empty by default and should be 
filled properly, or to be left empty in case of a horizontal branch. 

21. Chimney number: The number of the Chimney to which the connection pipe (if any) 
is being directed should be filled.  

22. Connecting flue pipe type: If a connecting flue pipe is required at the specific 
section, we need to fill its geometrical type (i.e. circular, square etc). 

23. Connecting flue pipe cross section (cm²): The calculated cross section of the 
connecting flue pipe is shown in this column. The user can easily change it by pressing 
the key F12 and filling in the “Desired cross section for connecting flue pipes” field.  

24. Coincidence GI: The default value of the equipment schedule that was defined in the 
“Network” window can be modified here for each specific section. The “GI” refers to gas-
fired appliances that are commercially or industrially used. 

25. Type of pipe: The user can define whether this branch refers to a main or secondary 
pipe (in case there are two different types in the same network). The user defines the 
types of the main and the secondary pipes from the ‘’Project Data’’ > ‘’Network’’ window. 

26. Pipe design length (m): Sometimes, when drawing a vertical diagram, you may 
design very short or very long sections. For that reason, you can define an arbitrary pipe 
length in this column, which however can result to the desired aesthetical aspect in his 
design. Regardless of the length that you define in this field, the program shall write the 
real pipe length on the drawing. It should be pointed out that in case you do not fill-in this 
field, the program shall draw the vertical diagram based on the column ''Pipe Length'' of 
the Calculation Sheet.  

27. Floor of appliance: The number of level is filled here automatically and updates the 
“technical report” of the project. 

28. Main gas stopcock: Depending on the value (“Yes” or “No”) the main gas stopcock is 
shown at the axonometric drawing.  

29. Passing through the soil: The user fills “Yes” or “No” depending on the case. If the 
field remains empty the program assumes that the passage is out of the ground. This 
information is used for the update of the technical description.  

30. T part exists: Depending on the value “Yes” or “No” the respective fitting appears on 
the axonometric drawing. For instance, if we define this fitting on the 2.3 section, then it 
will appear on the node “2”. 

Fields Calculated 
Fields corresponding to results calculated by the program are the following: 

31. Fittings Sz: The total sum of the local z resistances is being shown. 

32. DH Elevation difference (m): The height difference is shown (in m) with a positive 
prefix for ascending network sections and negative prefix for the descending sections. 

33. Number of H appliances (gas stoves, gas cookers, gas stove tops, gas ovens and 
the cooking and baking part of gas ranges). 

34. H appliances gas flow rate (m³/h) 
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35. Coincidence Factor H 

36. Gas flow rate multiplied by concurrency H appliances 

37. Number of DWH appliances (gas flow water heaters). 

38. DWH appliances gas flow rate (m³/h) 
39. Coincidence Factor DWH 

40. Gas flow rate multiplied by concurrency DWH appliances 
41. Number of RH appliances (gas space heaters, gas storage water heaters and the 
heater part of gas ranges). 

42. RH appliances gas flow rate (m³/h) 
43. Coincidence Factor RH 

44. Gas flow rate multiplied by concurrency RH appliances 
45. Number of UWH appliances (gas circulating water heaters, gas combi water heaters 
and gas heating boilers where Q ≤ 30 kW). 

46. UWH appliances gas flow rate (m³/h) 
47. Coincidence Factor UWH 

48. Gas flow rate multiplied by concurrency UWH appliances 
49. Number of GI appliances (commercial or industrial gas-fired appliances and central 
hot water heaters and heating systems in conjunction with gas heating boilers where Q > 
30 kW). 

50. GI appliances gas flow rate (m³/h) 
51. Coincidence Factor GI 
52. Gas flow rate multiplied by concurrency GI appliances 
Summarizing, if you follow the above standardization and fill-in the data for all the network 
sections, then the flow rates in the sections without appliances are summed and are 
presented automatically in the column for the flow rate. Based on the peak capacity in 
each network section and given the maximum velocity that corresponds to this section, 
the cross-section of the section pipe is established. Despite all this, you can select 
another standardized diameter from the list of standardized diameters of the library that 
appears on the screen. In whatever way the section has been defined, the effective gas 
velocity and the friction losses of the piping and components in the respective section of 
the network will be exactly calculated. 

Fixed column: Moreover, through the "Calculation Sheet" menu, you can select the 
"Fixed Column" so that the first column of the sheet "freezes" on the screen. Thus, as you 
fill in the fields of the sheet and you are "led" towards the right, you will know at any time 
on which network section you is working. When the "Fixed Column" option is active, a 
yellow point (pin) appears at the bottom of the "frozen" field. 

3.7.8 Chimney calculations  
This window presents the results of the calculations concerning the chimney (or 
chimneys) included in the project.  
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Chimney no = In this field the user types the number of the chimney which will be 
calculated (in case there is more than one chimney).  

Appliances of chimney gas flow rate = The total flow rate of the appliances that are 
connected to the chimney is presented in m³/h. 

Nominal power of appliances of the chimney = The total nominal power of the 
appliances that are connected to the chimney is presented in KW. 

Number of chimney appliances = The total number of the appliances that are connected 
to the chimney is presented in this field. 

Type of appliances in chimney = In this field the type of the appliances that are 
connected to the chimney is presented. The type is loaded automatically from the 
Libraries > Appliances. 

Minimum hydraulic diameter required = When all the fields of the “Chimney 
calculations” window have been filled in correctly, the minimum hydraulic diameter of the 
chimney (in cm) is calculated automatically. In case a necessary field of this window has 
been left blank, in this field an appropriate message will be shown. 

Chimney cross sectional area type = select the type of the chimney (square, circular 
etc.)  

Length or diameter of the selected chimney (cm) = When the minimum diameter of the 
chimney has been calculated, fill in this field with the length (in case of square or 
orthogonal) or diameter (in case of circular) of the chimney to be placed. The diameter 
must be equal or higher than the calculated minimum diameter. 

Width of the selected chimney (cm) = When the minimum diameter of the chimney has 
been calculated, fill in this field with the width of the chimney to be placed (in case of 
square or orthogonal). The width must be equal or higher than the calculated minimum 
diameter. 
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Hydraulic diameter of the selected chimney = The diameter of the chimney is 
calculated automatically taken into account the previous dimensions. 

Wind velocity pressure = In this field the user selects from the list the pressure which is 
generated on the chimney due to the wind. 

External air temperature TL = In this field the user defines the external air temperature in 
°C. The external temperature shall be taken as the maximum temperature of external air 
at which the chimney is intended to be used (for heating systems is normally 15 °C). 

Mean ambient air temperature of the chimney Tu = In this field the user defines the 
mean ambient air temperature in °C.  

Ambient air temperature at the chimney outlet Tuo = In this field the user defines the 
ambient air temperature at the chimney outlet in °C. For chimneys operating under dry 
conditions Tu =0 °C while for chimneys operating under wet conditions Tu =-15 °C. 

Flow safety coefficient SE = In this field the user selects the flow safety coefficient in 
order to take into account the local resistance in the flue gas collector. 

Additional data for the connecting flue pipe  

Connecting flue pipe 1 temperature for temperature instability = When the chimney 
has been calculated, the temperature of the connecting flue pipes is automatically 
calculated. By pressing the selection button in the field, the user can edit the data of the 
connecting flue pipe. 

Additional data for the chimney 

Extended length of chimney = In this field the user defines the extended length of the 
chimney (in m), that is the difference in height between the axis of the lower flue gas inlet 
into the chimney and the outlet of the chimney. 

Chimney effective height = In this field the user defines the effective height of the 
chimney (in m), that is the difference in height between the axis of the higher flue gas inlet 
into the chimney and the outlet of the chimney. 

Sum of local resistivities of the chimney Sz = In this field the sum of the coefficients of 
flow resistance due to directional and/or cross sectional and/or mass flow changes in the 
flue is calculated by pressing the selection button. 

Chimney thermal resistance 1/L = The thermal resistance of the chimney shall be 
obtained from the product manufacturer (in m²K/W). For multiwall custom built chimneys, 
the thermal resistance shall be determined from the layers data which will be defined by 
pressing the selection button in the field. 

External heat transfer coefficient aa = The external heat transfer coefficient shall be 8 
W/(m²K) for connecting flue pipes and chimneys internal to the building or 23 W/(m²K) for 
connecting flue pipes and chimneys external to the building. 

Chimney roughness value r = In this field the user selects from the list the chimney 
roughness value depending on the chimney material.  

Ventilation installation = In this field the user selects whether there is a ventilation 
installation in the space. 

Chimney temperature for temperature instability = In this field the temperature of the 
chimney (in °C) for temperature instability is calculated automatically.  

Stability conditions satisfaction for the desired diameter = When the minimum 
hydraulic diameter of the chimney has been calculated and there is “YES” in this field, the 
chimney has been calculated correctly, otherwise the user has to make changes in order 
to satisfy the stability conditions.  
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3.7.9 Network Drawing 
The numbered network drawing is shown on the screen, provided that polar coordinates 
have been inserted in every network branch (see calculation sheet). 

3.7.10 Vertical diagram (Chart) 
If the user wants to create a vertical diagram using the calculation sheet (and not 
automatically, using FINE NGAS package), the above option creates the vertical chart 
provided that the polar coordinates have been inserted in every network branch. At the 
bottom we find the Counters. 

It is pointed out that it is possible to select a drawing for the engine room from the menu 
''Vertical diagram'' > “Select side for machine room”. 

Axonometric drawing: The axonometric drawing is being generated exactly as the 
vertical drawing, by filling a value in the “Polar Angle” column, on the “Calculation Sheet” 
(instead of the angle values 0, 90, 180, 270 the values 30, 150, 210, 330 could be used). 

 
By activating the two windows “Calculation Sheet” and “Vertical diagram” as in the 
following screenshot, and by modifying some values, the user can understand easier this 
functionality, given that the drawing is being shaped on real time basis. 
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3.7.11 Sections Friction losses 
In this window you can calculate and view in the screen the total frictions in all sections (or 
routes), starting from the gauge and ending in each terminal node. Moreover, for more 
convenience, the most unfavorable section appears in the bottom of the window. 

3.7.12 Bill of Materials-Costing 
The bill of materials-costing results regarding the specific project is presented. You can 
edit the bill of materials-cost estimation sheet, modify the costs or quantities, insert 
discounts and add jobs or materials followed by their costs and quantities. 

3.7.13 Detailed Bill of Materials  
The exact quantity of the materials that have been used in the specific installation (i.e. 
pipes, appliances etc.) is being generated by the program in an editable table form. 

3.7.14 Technical Description 
The window “Technical Description” supports the creation of the project technical 
description. You can select among various technical description prototypes and text 
editing styles. To load a different technical description, in the program menu go to 
Technical description -> Prototypes, select the prototype you want and press “Load”. If 
you want to save the technical description you made so as to use it again, in the same 
window enter a name and a number (e.g. 02 Gas technical description) and choose “Save 
as”. 

Note: The technical description files are stored in FINE14_NGAS\CALC\KAER\ , 
named KAERTP01.RTF, KAERTP 02.RTF, etc. their descriptions are stored in the file 
KAERCV.LST. 

3.8 Libraries 
The FineNGAS Libraries include the following categories, with their respective features: 

• Fittings, with specified characteristics (description, coefficient z, cost) 

• Pipes (pipe types) with a given roughness, standardization (nominal, internal 
diameter, weight, capacity etc.), material and cost. 

• Appliances with lots of appliances of all five categories (DWH, GI, H, RH and 
UWH), their thermal power, gas flow, type, connection diameter etc. 
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• Systems of appliances: The library is fitted with a tool that allows the design of 
new receptor systems as well as the modification of the existing ones. 

The creation and/or modification are being easily performed through a smart wizard who 
allows the user to add or remove a gas appliance in a visual way. 

 
The user has also the option to import any dwg file.  

• Offer libraries where the user can add his own libraries. 

In any of the above libraries, you can easily change or add your own information. In order 

to add a new fitting, appliance etc. press the “Append record” button  at the bottom of 
the page. The program automatically creates a new blank row where you add the 

information you want and after pressing the “Post edit” button  you press OK. In this 
way, you can use your own libraries in every project you are working. 
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3.9 Help 
This option provides the user with the instructions of the program, according to the 
windows standards. 

3.10 Examples 
In this chapter two step-by-step examples are presented, which will help you understand 
in practice the basics of drawing in FINE NGAS. These simple examples aim mainly at 
helping you start drawing building entities (walls, openings etc.) along with the gas 
network. More specifically: 

- Example 1, describes the steps of drawing a simple level (optional). 

- Example 2, describes the steps of drawing a simple fire gas installation network, 
proceeding to the calculations and generating the necessary drawings.  

Important: It isn’t necessary to draw the levels of the building with walls, openings 
etc. in order to calculate the gas network. If you already have 2D architectural drawings of 
the levels, you can insert them and place on them the receptors, the pipes etc. 
Nevertheless, if you do not have architectural drawings, it will be more helpful to draw the 
walls etc. so as to be able to design the network more accurately.  

Apart from the following examples, you can watch the same steps (and much more) in the 
videos you will find in http://www.4msa.com/FineGasENG.html or in 
http://www.youtube.com/watch?v=zAP91yhK2D8. 
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3.10.1. Building design example 
In this example, the drawing of the 
adjacent simple building is described, 
including the steps from the beginning 
(creating a new project) to the end so that 
you can easily understand the function of 
FINE NGAS in practice. 

For this example, we will import two 
architectural plan views that have been 
designed in AutoCAD although you can 
start drawing from scratch. If you have 
already designed the building in IDEA 
Architecture 14, you can skip this 
example. 

1. From FILES menu, we select “New 
project”, type “Example_1” and press “Accept”. 

2. From AutoBLD menu, we select “Building definition”, define as level 1 the “Basement” 
in elevation “-3” and from “File” we load its architectural drawing. Before we define the 
second level, we press “New” (so as to save the changes) and we follow the same 
steps for the second level, as it is shown below. 

 
When we finish, we press once again “New” and then “Accept” and automatically we 
defined the two levels with their architectural drawings. 

3.  Before we start drawing, we “Lock” the architectural drawings from the layers list on 
the left by pressing the “Lock” symbol as it is shown below. The name of the 
architectural drawing will be BASE_FLOO1_XREF for the first level, 
BASE_FLOO2_XREF for the second level etc. 
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4. From AutoBLD, we select Walls > Outer wall and 

in the properties window we define the height (3 m 
in our example) and the width (0.25 m) of the wall, 
the height and the width of the column (it will be 
automatically designed along with the wall), its type 
etc. 

When we finish, we press “Accept” and we design 
the wall by defining three points: 

- First, we click on the beginning of the wall  
(where the left red spot is, in the following 
image) 

- Then, we click on the end of the wall (where 
the upper right red spot is) and 

- Finally, we click on the side that the wall “grows” (where the down right red spot 
is). 

 
You can enable the “Entity snaps” toolbar (or the “ESNAP” setting) so as to select 
easily the edges of the wall. 
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Continuing in the same way, we draw all the walls (inner and outer) of the ground 
floor. 

 
5. From AutoBLD, we select Opening > Door and in the properties window, we select the 

height (2.20 m in our example), the length (1 m), the type of the door etc.  

When we finish, we press “Accept” and we design the 
door: 

- First, we select the wall upon which we want to place 
the door. 

- We click on the starting point of the door  (where the 
left red spot is, in the following image) 

- We click on the ending point of the door (where the 
upper right red spot is). As long as you have 
specified the length of the door, it is not necessary to 
specify this point exactly. You only need to specify a 
point near the start towards the side that the second 
point is located.  

- Finally, we click on a point that shows the direction towards which the door will 
open (where the down right red spot is). 
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6. From AutoBLD, we select Opening > Window and in 
the properties window, we select the height (1.20 m in 
our example), the length (1 m), the rise (0.80 m), the 
type of the window etc.  

When we finish, we press “Accept” and we design the 
window: 

- First, we select the wall upon which we want to 
place the door. 

- We click on the starting point of the window  (where  
the upper red spot is, in the following image) 

- We click on the ending point of the window (where 
the down red spot is). As with the door, as long as 
you have specified the length of the window, it is not necessary to specify this 
point exactly. You only need to specify a point near the start towards the side that 
the second point is located.  

 
In the following image, we have deactivated the architectural drawing, so as to have a 
better inspection of the drawing. To do this, go to AutoBLD > Layers management > 
and uncheck the “XREF” box.  
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3.10.2. Gas installation Network design example 
1. First of all, we place the appliances in the rooms of the ground floor. From AutoNET > 

Receptors (or directly from the “receptors” symbol of the toolbar), we select the “Gas 
stove”, press “Accept” and place it in the first room. Repeating the same step, we 
place in the same room the gas-flow water heater and in the level of the basement the 
gas-fired heating boiler. 

Before we place the water heater in the drawing, from the ‘’Plus’’ menu > we can 
select “Set elevation” and in the command line type the elevation we want for the 
water heater to be placed (e.g. 1.6 m). In this way, the water heater will be placed in 
1.6 m in z axis in relation to the ground floor level. After we place the water heater, we 
restore the elevation with the same command.  

 
2.  From AutoNET > we select “Pipe” (or from the gas toolbar as highlighted below) and 

start drawing the gas network of the ground floor. If you want, you can draw the pipes 
in a different elevation by repeating step 1 (in our example, we draw the water heater 
in an elevation of “1.6” m) or draw curved pipes (from AutoNET > ‘’Curved pipe’’). 

 
We repeat the same steps for the basement as it is shown below. 
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3. The next step is connecting the pipes with the receptors and we do this easily by 

selecting from AutoNET > ‘’Connect receptors to existing pipe’’ (or from the 

corresponding symbol   of the toolbar).  

- We click on the receptor 

- We click on the pipe next to it 

- We press ENTER and they are automatically connected. 

- We repeat the step for all the receptors (we can connect more than one receptor to 
the same pipe each time). 

- We delete the part of the pipe that we no longer need. 

 
4. If we want to place a vertical pipe that leads from the basement to the ground floor, we 

select from AutoNET > ‘’Main vertical pipes’’: 

- We click on the location we want to place the vertical pipe (in the command line 
you can see the “Enter XY location” prompt message). 

- We type the height “-3” which is the starting point of the vertical pipe in this 
example (the basement elevation). 
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- We type the height “0” which is the ending point of the vertical pipe in this example 
and the vertical pipe is created. 

 
5.  From AutoNET > we select ‘’Pipe’’ and draw a pipe connecting the horizontal to the 

vertical pipe as it is shown below. 

You can use the “Perpendicular snap” (it is highlighted in the picture) to connect 
precisely the horizontal to the vertical pipe. 

 

6. By selecting the level of the ground floor (you can use    to change levels or 
double click on the level’s name in the left side of the screen) we draw a horizontal 
pipe starting from the vertical pipe as it is shown below. 

Finally, from AutoNET > ‘’Supply point’’, we set the supply start point symbols (which 
is for the gas meter position). You can easily connect the symbol to the horizontal pipe 
using the “Endpoint snap” point (highlighted in the following picture). 
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7. The next step is to place the chimneys on the drawing. On the basement, from the 

AutoNET menu  > we select “Chimneys-Uptakes” > “Orthogonal chimney” (or from the 
toolbar as it is highlighted below): 

- We click on the location we want to place the chimney (in the command line you 
can see the “Enter XY location” prompt message). 

- We type the height “-3” which is the starting point of the chimney in this example 
(the basement elevation). 

- We type the height “8” which is the ending point of the chimney and automatically 
the “Chimney 1” is placed. 

 
We repeat the same step for the chimney of the ground floor (starting point: 0 m, 
ending point: 8 m) and “Chimney 2” is placed on the drawing as it is shown in the 
following image. 
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8. From AutoNET menu we select “Chimneys-Uptakes” > “Assign chimney to receptor” 

(or from the toolbar as it is highlighted below). On the basement, we select the heating 
boiler, press <Enter> and type the number “1” in the prompt message “Select Chimney 
that Receptors will Place Among”. 

We repeat the same for the water heater of the ground floor, only typing “2” for the 
chimney number. 

 
9. Before we proceed to the calculations, we select from AutoNET > ‘’Network 

recognition’’. This is an important step in order to make sure that the network has 
been drawn correctly. If there are any mistakes, a warning message will appear, 
otherwise, the network sections are numbered as it is shown below and we can 
proceed to the calculations. 
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10. From AutoNET > we select ‘’Calculations’’ and in the window that opens 

automatically, we select Files > Update from Drawing.  From ‘’Windows’’ menu we 
open the Calculation Sheet where the network information have been transferred and 
make any changes we want (detailed information in Chapter 3.7.7). 

 
11. In order to calculate the diameter of the chimneys, from ‘’Windows’’ menu we open the 

“Chimney calculations”. 
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In the above window: 

-  In “Chimney no” field we type “1” so as to calculate the first chimney. 

-  We fill in the “Extended length of chimney” and “Chimney effective height” fields. In 
the first chimney, only one appliance is connected so we type the same value of “11” 
m in both fields (the chimney starts from an elevation of -3 m and ends in elevation of 
8 m). 

-  Automatically in the field “Minimum hydraulic diameter required for the chimney” the 
calculated diameter of 8.50 cm is shown. 

- We fill in the field “Length or diameter of the selected chimney” with the diameter 10 
cm and the stability conditions are satisfied (in the last field of the window). 

We repeat the same steps for the second chimney.   

When we finish the calculations, we save and close the window and return to FINE 
NGAS. 

12. From AutoNET we select ‘’Update Drawing’’ and in the opening window we choose 
which information we want to be show on the screen for the pipes and the receptors. 
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By clicking “Auto Placement”, the selected information is shown on each level. 

 
13. If we want, from AutoNET we can select ‘’Convert single line to 3D’’ and the 

program automatically converts the network into 3D in relation to the calculation 
results. 

 
14. Finally, we can generate the axonometric diagram of the network from AutoNET > 

“Axonometric diagram” > “Create”. Automatically a new drawing is created with the 
axonometric diagram and its data as it is shown below. 
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